
                    [image: alt]
                
        
            
                                        
        
        
    

    
        

    


    
        
            
                                    
                        [image: pdfFiller]
                    
                            

                        
                
                    	Startseite
	
                                                                            Für Unternehmen
                                                                        
                                        
                                                                                            Unternehmen

                                                                                        Organisationen

                                            Medizin

                                            Versicherung

                                            Immobilien

                                            Steuern und Finanzen

                                            Recht

                                            Personalwesen

                                            Alle anzeigen

                                        

                                    

                                
	
                                                                            Entwickler
                                                                        
                                        
                                            API-Tools für PDF

                                            pdfFiller-API

                                            API-Dokumentation

                                            API-Preise

                                            Integrationen
                                                
                                                    
                                                        Salesforce

                                                        Dynamik

                                                        Alle anzeigen

                                                    

                                                

                                            

                                        

                                    

                                
	Funktionen
	Kundendienst
	
                                                                                                                                    Kostenlose Testversion starten
                                                
                                                                                                                        
	
                                            Preisgestaltung
                                        
	Anmelden


                
            

                        
                
                    
                
            

        

    



                            

            
                                    
    
        
            

        

        
            
                                                            Startseite

                                                                                
                            Für Unternehmen

                            
                                Unternehmen

                                Organisationen

                                Medizin

                                Versicherung

                                Immobilien

                                Steuern und Finanzen

                                Alle anzeigen

                            

                        

                                                                                
                            Entwickler

                            
                                API-Tools für PDF

                                pdfFiller-API

                                API-Dokumentation

                                API-Preise

                                Integrationen

                            

                        

                                                                                Funktionen

                                                                                Kundendienst

                                                                                Preisgestaltung

                                                                                Anmelden

                                                

        

        
                            Anmelden

                Sie haben noch kein Konto? LOS GEHT'S

                    

    




                            
            

            
                
        
        
            
                    	
                    
                        Startseite
                    
                
	
                    Index der Funktionalität
                


    
            

            
                                Word Tool For Education Online
                            

                            
        
            

        

                    

    



    


                            Note: Integration described on this webpage may temporarily not be available.

            

            
                
            

            
                
                    
                        
                            

                            
                                0

                                Forms filled

                            

                        

                    

                    
                        
                            

                            
                                0

                                Forms signed

                            

                        

                    

                    
                        
                            

                            
                                0

                                Forms sent

                            

                        

                    

                

            

        

    
    
    
    
    
        
            
                
                    
                        
                        
                        [image: Function illustration]
                    
                    
                                                    Upload your document to the PDF editor
                                            

                

            

            
                
                    
                        
                        
                        [image: Function illustration]
                    
                    
                                                    Type anywhere or sign your form
                                            

                

            

            
                
                    
                        
                        
                        [image: Function illustration]
                    
                    
                                                    Print, email, fax,  or export
                                            

                

            

            
                
                    
                        
                        
                        [image: Function illustration]
                    
                    
                                                    Try it right now! Edit pdf
                                            

                

            

        

    


        
    
        Users trust to manage documents on pdfFiller platform

        
                                                
                        65.5K+

                        documents added daily

                    

                                    
                        53%

                        of documents created 
from templates
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                        PDFs edited per month

                    

                                    
                        238K

                        documents shared 
per month

                    

                                    

    


            
    
        
            
                All-in-one PDF software
            

            
                A single pill for all your PDF headaches. Edit, fill out, eSign, and share – on any device.
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        See for yourself by reading reviews on the most popular resources:
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                                    2017-08-09

                                

                            

                            
                                
                                    It's pretty good. There is a delay from when I type till when the text appears in the text box.Also, I don't like have each field with a help box.  I know I can X it out but it gets in the way when I want to go fast.  I do like that it goes automatically from one field to the next such as with the dates.
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                                    User in Health, Wellness and Fitness

                                    

                                

                                
                                    2018-12-20

                                

                            

                            
                                
                                    What do you like best?

I use it as a healthcare EHR. Very convenient.

What do you dislike?

I only really have one complaint. When I use it to fill my PDF files, the pop up bubble gets in the way after I click a box so then I have to click somewhere else to see my next option.

Recommendations to others considering the product:

Great.

What problems are you solving with the product?  What benefits have you realized?

Send to sign is convenient. Send to fax is also nice. 
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                    Get a powerful PDF editor for your Mac or Windows PC

                    Install the desktop app to quickly edit PDFs, create fillable forms, and securely store your documents in the cloud.

                    
                        Download pdfFiller for Mac OS

                        Download pdfFiller for Windows PC
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                    Edit and manage PDFs from anywhere using your iOS or Android device

                    Install our mobile app and edit PDFs using an award-winning toolkit wherever you go.

                    
                        Download from App Store

                        Download from Google Play
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                    Get a PDF editor in your Google Chrome browser

                    Install the pdfFiller extension for Google Chrome to fill out and edit PDFs straight from search results.

                    Download from Chrome Web Store
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                                    For pdfFiller’s FAQs
                            

            
                                    Below is a list of the most common customer questions. If you can’t find an answer to your question, please don’t hesitate to reach out to us.
                            

            
                                    
                        
                            
How do I enable learning tools to Word?
                        

                                                    In Word, find learning tools under the View tab. Slide the toggle to the right to launch the Learning Tools tab. On the Learning Tools tab you have the following tools that can assist you while you read or edit your document.

                                            

                                    
                        
                            
What are learning tools in Word?
                        

                                                    In Office, the Microsoft Learning Tools is a set of features available in Word designed to help you improve reading skills no matter your age or ability. The idea with these tools is to remove distractions and offer proven techniques to improve reading fluency and comprehension.

                                            

                                    
                        
                            
What are the learning tools?
                        

                                                    A variety of tools can be used in the classroom to support student learning, ranging from traditional to high-tech options. Examples include the whiteboard, index cards, posters, audience response systems (e.g. clicker technology), Google collaboration tools, 3D printing, and wikis.

                                            

                                    
                        
                            
What is immersive reader in Word?
                        

                                                    Microsoft's Immersive Reader is a free tool that provides a full-screen reading experience. It is designed to increase readability of text in Microsoft applications through the use of assistive technology accommodations for people with print disabilities such as dyslexia, dysmorphia, vision impairment, and more.

                                            

                                    
                        
                            
What is the learning tools for OneNote?
                        

                                                    Learning Tools for OneNote is a free Add-in for OneNote that helps everyone improve reading and writing skills, including gifted learners, students with learning differences or a combination of a broad range of unique learning abilities.

                                            

                                    
                        
                            
Where is the Tools' menu in Word?
                        

                                                    Above the page, at the top of the MS Word screen, you will see the Menu bar. The Menu bar lists File, Edit, View, Insert, Format, Tools, Table, Window, Help. Point with your mouse to any of those words and then click your mouse button to display the particular menu.

                                            

                                    
                        
                            
Where is the Tools' menu in Word 2007?
                        

                                                    There is no Tools menu, or most other menus, in Word 2007. Instead, click the big round Office button in the upper left corner (some call it the “pizza button”), and then click the Word Options button in the bottom right corner of the panel that appears.

                                            

                                    
                        
                            
How do I get my toolbar back on Microsoft Word?
                        

                                                    0:33
1:23
Suggested clip
How To Hide Or Show Ribbon Bar In Microsoft Word — YouTubeYouTubeStart of suggested client of suggested clip
How To Hide Or Show Ribbon Bar In Microsoft Word — YouTube
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